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What is RVCS? 
The Road Vehicle Certification System (RVCS) allows vehicle manufacturers to electronically 
submit applications for vehicle certification to Vehicle Safety Standards (VSS). 

Vehicle manufacturers can use RVCS to complete and submit applications for certification of 
vehicles they supply to the Australian market using electronic forms designed specifically for 
RVCS. 

The RVCS electronic forms require the form management software, Informed® Filler, which 
VSS will provide on CD or you can download off the Internet from the RVCS web site.  This 
software enables users to create forms from templates, enter data in forms and save the forms 
for later submission to VSS.  There is no charge for the Informed Filler software, however your 
Internet Service Provider may charge you either by the hour or by the amount of data 
downloaded, if you download from the Internet. 

The RVCS web site is the central focus point of the RVCS application.  From the web site, you 
can download required software and associated form templates, download any upgrades to 
software, view the status of your current applications and the discussion list which shows any 
points requiring discussion with VSS.  The web site also receives the forms submitted.  
Commercial sensitive data is either password protected on the web site or stored within VSS 
internal network. 
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System Requirements 
In order to access RVCS and successfully run Informed Filler and associated software, you must 
meet a minimum software and hardware requirement. 

Operating Systems 
You can run RVCS using the following operating systems: 

• MacOS on PowerPC 

• Windows 95, 98, 2000 and NT  

Hardware and Software 
To run RVCS and Informed Filler you will need to have the following hardware and software: 

Windows 
• 486 or better with at least 16MB RAM 

• Hard drive with at least 100MB of free disk space (15MB for the software, 
85MB for the form templates) 

• Windows 95 OSR2 or later including NT4 SP3 or Win98/2000 

 Power Macintosh 
• Power PC or better with at least 2.5MB RAM free per application 

• Hard drive with at least 62MB of free disk space 

• System 8.5 or later. 

• File compression and extraction utility, such as StuffIt 

 

Note: Macintosh software provided on request only 

Internet Access 
RVCS users will need access to the Internet to submit applications to VSS and maintain 
communications with VSS for updates on application status and discussion lists.  Contact your 
system administrator or computer supplier for details on Internet browsers suitable for your 
operating system and Internet requirements. 
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Getting Started 
Access to the RVCS electronic forms and the secure area of the RVCS web site is only available 
to Licensees or Agents of Licensees registered with Vehicle Safety Standards (VSS).  See 
Registering with VSS on page 44. 

When you register with VSS, you will receive a web user name (via e-mail) and a 
corresponding password (via post) which you will need to logon to RVCS.  If you have not yet 
received your web user name and password or you have forgotten your web user name or 
password, contact the RVCS Help Desk on (02) 6274 7766. 

Note: Agents who register with VSS will receive a web user name and password 
when they are nominated as a signatory for a registered Licensee. 

Once you receive your web user name and password, you can change your password if required.  
See Changing Your Password on page 33. 

Logging on to RVCS 
If you have requested that VSS provide the Informed Filler software and templates on CD-
ROM, you do not need to logon to RVCS at this stage. 

Once you receive your web user name and password you can use your Internet browser to logon 
to the RVCS web site.  From the RVCS web site you can download the required software (if not 
requested on CD-ROM) and maintain contact with VSS during the application process. 

To logon to RVCS 

1. Go to the RVCS home page at:  http://www.dotrs.gov.au/rvcs 

2. At the RVCS home page, click Participant's Log On. 

3. At the Logon page, enter your web user name and password then click Log 
On. 

The browser displays the RVCS page from which you can perform the 
following functions: 

• Download Informed Filler 

• Download form templates 

• Change your password. 

• Check the status of your applications 

• View discussion lists for your applications 
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Installing Required Software 
(for Windows) 

To submit RVCS forms electronically, you will need to install: 

 Informed Filler 

 RVCS supporting files 

 RVCS form templates 

All the software required for submitting electronic forms is available off the RVCS web site or 
on CD-ROM from VSS.  VSS supplies and supports this software to licensees free of charge. 

VSS will notify you of any upgrades or new releases of the required RVCS software (Informed 
Filler, RVCS templates and supporting files).  For information on upgrading RVCS software see 
Upgrading Required Software on page 31. 

Informed Filler 
The RVCS electronic forms require the form management software, Informed® Filler, which 
you can download and install off the Internet from the RVCS web site or from the CD-ROM 
supplied by VSS.  This software enables users to create forms from templates, enter data in 
forms and save the forms for later submission to VSS. 

The software is downloaded as a self-extracting executable file, setup.exe, which, when 
executed, automatically installs the Informed Filler software into its correct directories. 

Note: There is no charge for the Informed Filler software, however if you 
download the software off the Internet, your Internet Service Provider may 
charge you either by the hour or by the amount of data downloaded.  If you 
wish to avoid these fees, you can request the Informed Filler software from 
VSS on CD-ROM. 

Downloading Informed Filler off the Internet 
You can download the Informed Filler software off the Internet at the RVCS web site.  This will 
take at least 30 minutes using a modem connection. 

Note: If you have received the RVCS software on CD-ROM, you do not need to 
download the software off the Internet as the setup file is provided on the 
CD-ROM. 

To download Informed Filler off the Internet 

1. Go to the RVCS home page at: http://www.dotars.gov.au/rvcs 

2. Logon to RVCS.  See Logging on to RVCS on page 3. 

3. At the RVCS page, click on the Download Page. 

4. At the Download Page, click Download Informed Filler 
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5. Save setup.exe to an appropriate directory on the drive on which you want to 
install Informed Filler. 

Installing Informed Filler 
Informed Filler is installed from setup.exe, which you can download off the Internet, or access 
directly from a CD-ROM supplied by VSS.  

To install Informed Filler 

1. Close any applications currently open. 

2. From within Windows locate and execute the Informed Filler setup.exe. 

Note: If you downloaded the file from the Internet, the file will be in the 
directory you selected in the extraction process.  If you have the 
software on CD-ROM, you can execute setup.exe directly from the 
\Filler directory on the CD-ROM. 

Setup.exe invokes the Informed Filler installation.  Follow the installation steps as prompted.  
The following parameters are suggested: 

Option Setting 

Customer Information Your name and company 

Destination Directory C:\Informed 

Setup Type Default (Typical) 

Program Folder Default (Informed) 

 

3. When the installation process is complete, restart your PC. 

Note: Do not run Informed Filler until all the supporting files are copied to 
your Informed directory. 

If installing Filler for use over a network, please see Sharing RVCS Files on a Network on page 
26 

 

RVCS Form Templates 
In addition to installing Informed Filler and RVCS supporting files, you will need to install the 
RVCS form templates to be used in Informed Filler to produce forms for submission to VSS. 

You can download the RVCS form templates off the Internet or copy them directly from the 
CD-ROM supplied by VSS. 

Note: Form templates are only provided on CD-ROM for new users installing 
software.  Following initial installation, new or modified form templates 
will only be accessible from the RVCS web site. 
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Downloading Form Templates off the Internet 
You can download the RVCS templates off the Internet at the RVCS web site.  A complete list 
of RVCS form templates is available in a self-extracting executable file, forms.exe, which 
contains all templates (recommended for new installations).  Templates are also available 
individually as required (for new and updated templates). 

Information on how to download templates individually off the Internet is provided in 
Downloading Individual Form Templates off the Internet on page 7. 

To download all RVCS form templates off the Internet 

1. Go to the RVCS home page at:  http://www.dotrs.gov.au/rvcs 

2. Logon to RVCS.  See Logging on to RVCS on page 3. 

3. At the RVCS page, click Form Templates. 

4. Save forms.exe to an appropriate directory on the drive on which you installed 
Informed Filler. 

5. Close any applications currently open. 

6. From within Windows locate and execute forms.exe. 

7. Specify the folder (directory) where Informed Filler is installed.   

For example, if Informed Filler is installed in the C:\Informed directory, you 
only specify C:, or if Informed Filler is installed in the 
C:\ProgramFiles\Informed directory, you specify C:\ProgramFiles. 

Note: Do not include \Informed. 

8. Click Unzip.  The templates are copied into the \Informed\Template directory.   

9. Click Close. 

Notes: 1. The RVCS form templates are installed in the \Template sub-
directory in the \Informed directory. 

 2. If you wish to move your templates to another directory or drive 
at a later stage, for example if you decide to run Informed Filler 
on a network, you must also change the setting which specifies 
the location of these files in Informed Filler.  See Sharing RVCS 
Files on a Network on page 26. 

Installing RVCS Form Templates from CD-ROM 
If you have requested the RVCS software on CD-ROM from VSS, you can install the RVCS 
form templates by simply running the “forms.exe” file locate on the CD-ROM. When prompted, 
specify the directory where Informed Filler is installed.  By default, “forms.exe” will install to 
C:\Informed. If you wish to move your templates to another directory or drive, you will need to 
set the path before executing the unzip process. at a later stage 
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. 

Note: If you wish to install your templates to another directory or drive, for 
example if you decide to run Informed Filler on a network, you must also 
change the setting which specifies the location of these files in Informed 
Filler.  See Sharing RVCS Files on a Network on page 26. 

Downloading Individual Form Templates off the Internet 
You can download new and updated RVCS form templates individually off the Internet at the 
RVCS web site. 

To download individual RVCS form templates off the Internet 

1. Go to the RVCS home page at:  http://www.dotrs.gov.au/rvcs 

2. Logon to RVCS.  See Logging on to RVCS on page 3. 

3. At the RVCS page, click Form Templates. 

4. Select the name of the form template that you want to download and save it to 
your template directory, such as \Informed\Template. 

Running Informed Filler for the First Time 
When you first start Informed Filler you will need to enter the Informed Filler Registration 
Number.  You should have received this number from VSS when you were successfully 
registered in RVCS as a Licensee or Agent of a Licensee.  The Registration number is located 
on the underside of the CD case.  People who have downloaded Informed Filler from the RVCS 
website, will need to contact  RVCS Help Desk to obtain a Filler Registration number. 

RVCS Help Desk: 

Phone:  (02) 6274 7766 
Fax:  (02) 6274 6525 
E-mail:  rvcs@dotars.gov.au 

To enter the Informed Filler registration number 

1. Select Filler from the Informed menu item in the Program section of the Start 
Menu or double-click on the Informed Filler® application icon: 

 
or, 

Run the executable Filler.exe from the \Informed directory (Windows only). 

The system displays the License Agreement window. 
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2. Click Register.  The system displays the Register dialogue. 

Enter Informed Filler registration number from the back of your CD. 

3. Click OK.  The system displays the License Agreement for your review. 

4. Click Accept to complete the registration of Informed filler. 

The system displays the New Data Document dialogue from which you can 
select a template to create a new form. 

 

See 

Completing Forms on page 11 for details on how to complete forms. 
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Submitting an Application to VSS 
A submission sent to VSS can contain one or many application forms.  For each new 
application, you will need to submit, at least, a Routing Slip, a Compliance Application (CA for 
Motor Vehicles, CA 38/- application for SARN, CA for Motor Vehicle SARN, Compliance 
Application for Trailers or a Component Registration Number Application) form and for Motor 
Vehicles a Road Vehicle Descriptor (RVD) form.  In return, VSS will provide you with an 
application number, which you must enter on every subsequent Routing Slip submitted for that 
application.  For each application you can submit one, or several, subsequent Routing Slips with 
attached forms.  A Payment Advice form is required for trailers, 38/- SARN and Low Volume 
applications 

Note: Applications must be submitted by active, registered signatories otherwise 
they will be rejected by RVCS. 

You can make the following submissions to VSS: 
New Application An application for a make-model (vehicle, component or 

sub-assembly) which has not been submitted previously.   

Requires:  Routing Slip without an application number, a 
Compliance Application form, a Road Vehicle Descriptor 
form (motor vehicles only) and Summary of Evidence 
forms. 

Further Information Used for application which have not yet been approved and 
provides responses to discussion items by way of revised 
evidence forms or other information. 

Requires:  Routing Slip with an application number, and 
Summary of Evidence forms or other forms as required. 

More Information Provides additional information, on electronic forms, to 
complete or partially complete an application that has not 
yet been approved.  (Not to be used when replying to 
discussion items.) 

Requires:  Routing Slip with an application number, 
Summary of Evidence forms or other forms as required. 

Amending Used for applications that have already been approved and 
introduces changes to the Approval document (eg.  New 
ADRs, licensee details, seating capacity). 

Requires:  Routing Slip with an application number, 
Compliance Application form, Summary of Evidence forms 
or other forms as required. 

Running Change Used for applications which have already been approved 
and introduces additional test results or advice of 
specification changes which potentially affect compliance 
with ADRs.  (Not to be used if the changes result in 
modifications to the Approval document.)  May involve 
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changes to the Road Vehicle Descriptor. 

Requires:  Routing Slip with an application number, 
Summary of Evidence forms or other forms as required. 

Routing Slips 
When you submit your application to VSS you must first complete and save any other forms 
which will be attached to the Routing Slip, such as CA, RVD or SE forms, Extension Sheets 
and Document Registers, then attach the forms to the Routing Slip (see Attaching files to Forms 
on page 24 for details).  When you submit the completed Routing Slip to VSS the attached 
forms are automatically sent with the Routing Slip.   

When completing a Routing Slip you need to ensure the Make and Model fields are exactly the 
same as what is stored in RVCS, including the number of spaces.  If you are submitting a new 
application the Make and Model names are taken from the CA form exactly as you have typed 
them, not those from the Routing Slip.  All subsequent submissions will check the Make/Model 
on the Routing Slip with those entries in the database.  If you are unsure of a Make or Model 
name you can check on the RVCS website. 

Warning: Do not attach the Routing Slip to itself.  This is surprisingly easy to do.  A 
Routing Slip attached to itself causes problems in RVCS.  Please take a second to check that 
your list of attachments does not include a Routing Slip. 

 

Please only attach Informed Filler forms to the Routing Slip.  If you need to send other sorts of 
files please attach them to the appropriate form  Word documents and image files for example 
should first be attached to the relevant piece of evidence and then this evidence complete with 
its attachment should be attached to the Routing Slip. 

Extension Sheet 
You will need to complete an Extension Sheet if an attached SE form refers to test evidence 
from more than one test facility.  An Extension Sheet can be used for more than one SE form. 

Document Register 
Document Registers are optional. You can attach a Document Register form to act as a table of 
contents, listing all the forms submitted with the Routing Slip.  

You can use the Document Register to keep track of: 

• the evidence forms submitted with a particular Routing Slip (particularly 
useful if your application requires several submissions), 

• the Australian Design Rules relevant to the application, and 

• any other notes of your choosing. 

You may find keeping a printed copy of the Document Register useful, even if you do not send 
an electronic copy to VSS.  Sending a copy to VSS with your submission may help resolve 
confusion over which vehicle configurations are covered by which forms. 
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Blank Sheet 
For Low Volume Motor Vehicles alternative methods of demonstrating compliance are 
accepted for certain ADRs.   

The Blank Sheet form allows you to describe how you are demonstrating compliance in these 
cases.  The form has a pop-up list of ADRs from which you must select the appropriate one.  
The rest of the form is blank allowing you to type in as much text as you need.  If required, you 
can attach other electronic files to provide additional information.  See Attaching Files on page 
23 for more information on this feature. 

Completing Forms 
To use RVCS electronic forms, you must have Informed Filler installed and RVCS supporting 
files and form templates downloaded.  See Installing Required Software on page 4. 

 

To complete a form you will need to: 

 Identify the correct form template to use 

 Ensure the template and associated supporting files are up to date (see the RVCS web site 
for the latest version) 

 Create a form using the appropriate template 

 Fill out the form 

 Save the form (print a paper copy if required for your reference) 

 

You complete and submit electronic RVCS application forms using the form management 
software, Informed® Filler.  This software enables users to create forms from templates, enter 
data in forms and save the forms for submission to VSS. 

Starting Informed Filler 
When you first start Informed Filler you will need to enter the Informed Filler Registration 
Number.  You should have received this number from VSS when you were successfully 
registered in RVCS as a Licensee or Agent of a Licensee.  See Running Informed Filler for the 
First Time on page 7. 

To start Informed Filler 

Select Filler from the Informed menu item in the Program section of the Start Menu or Double-
click on the Informed Filler® application icon: 
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or, 

run the executable Filler.exe from the \Informed directory (Windows only). 

The system briefly displays the Informed Filler’s welcome screen, then displays the New Data 
Document dialogue from which you can select a template to create a new form or open an 
existing form, depending on your startup setting. 

Note: You can set your Startup preference to open an existing form, rather than 
create a new form.  See Setting Startup Preferences on page 27. 

Creating a New Form 
All applications are submitted on forms created using RVCS form templates.  Before you can 
create any forms, you must download these templates from the web.  See Installing Required 
Software on page 4. 

To create a new form 

1. If the New Data Document dialogue is not already shown, choose New 
Document...  from the File menu.   

The system displays the following dialogue showing all the form templates in 
your template folder: 

 

2. Select a form template from the list. 

3. Click New.  The system creates and displays a new untitled form based on the 
selected template. 

4. Enter data in the form as required. 

5. Before forms are sent to VSS, you must save and name the form.  Each form 
must have a unique document reference number.  Before saving the form, 
check that there are no bell symbols ( ) or crosses ( ) at the top of the form.  
See Validating Data on page 22. 

6. Choose Save from the File menu. 

7. If you are saving a new form for the first time, specify the name of the 
document and the directory where it will be saved. 

You can maintain either electronic or paper copies of application forms on file. 
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Note: VSS require you to keep copies of forms that you submit and that the 
information used to complete an application is traceable. 

You may also open any recently opened templates from the file menu.   

1. Choose Recent Templates from the file menu. 

2. Select the appropriate template from the list.  

 

 
 

 

 

 

Opening an Existing Form 

To open an existing form 

1. Choose Open from the File menu. 

2. Use the Open dialogue to locate the form you want to open. 

3. Select the form. 

4. Click OK.  The system displays the existing form which you can update or 
submit, as requied. 

5. Before forms are sent to VSS, you must save and name the form.  Before 
saving the form, check that there are no bell symbols ( ) or crosses ( ) at 
the top of the form.  See Validating Data on page 22. 

6. Choose Save from the File menu to save the form with the same name, or 
choose Save As from the File menu to save the modified form under a 
different name. 

You can maintain either electronic or paper copies of application forms on file. 

Note: VSS require you to keep copies of forms that you submit and that the 
information used to complete an application is traceable.  
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Informed Filler 3.0 also gives you the ability to select any recently used forms from the file 
menu.   

1. Choose Recent Templates from the file menu. 

2. Select the appropriate template from the list.  

 

Submitting Forms 
RVCS enables you to submit electronic application forms to VSS directly from Informed Filler. 

Note: Before you submit an application, you must first save and name any forms 
associated with the application.  You must also have an Internet connection 
available.  If you use a dial up connection you will need to dial up and 
establish a connection before using File Submit. 

To submit a form to VSS 

1. Complete a Routing Slip form, attach all required forms and save the Routing 
Slip.  See Submitting an Application to VSS on page 9 for descriptions of 
acceptable application types. 

2. Choose Submit from the File menu. 

The Routing Slip and any attached files are sent immediately to VSS directly 
from Informed Filler via your Internet service.  The system displays a message 
indicating any errors or confirming the successful submission of your 
application. 

About four hours after you have submitted an application, you can check the 
application status and any discussion items for the application on the Internet.  
See Checking Application Status & Discussion Items on page 31. 



 
RVCS User Guide 

 

Page 15 

Printing Forms 
You can print a copy of the form for your own reference. 

You can print a completed form with data or a blank form with no data (which you can use to 
complete by hand if necessary). 

To print a form 

1. Choose Print...  from the File menu.  The system displays the following drop-
down list: 

 
2. Print the current form with data by choosing Current Record from the 

drop-down list. 

3. Print the current form without data by choosing Blank Form from the 
drop-down list. 
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Information for the Completion of 
RVD forms 
 

The RVD form contains information used to assess compliance of a vehicle with some of the 
requirements of the Australian Design Rules. It also provides information required for bulk 
registration and other purposes to the State and Territory registering authorities. 

Three separate RVD forms have been developed to cover a range of motor vehicle categories. 
These are; 

• RVD1- For LEP, LEG, MA, MB, MC, MD1, MD2, MD3, NA and NB1 Vehicles (ie. 
Under 4.5t) 

• RVD2- For MD4, ME, NB2 and NC vehicles (ie. over 4.5t) 

• RVD3- For LA, LB1, LB2, LC, LD, LE1, LE2, LEM1 and LEM2 vehicles. 

 

This section is provided to assist manufacturers in completing these RVD forms.  A set of 
printed forms is available on the RVCS web site.  

 

Explanatory Notes  
• A separate RVD is required for each Body Style that results in a different NSW Body 
Code. 

• If more than 5 variants a new RVD with a different reference number is required.  

• Where a vehicle is sold as a 3 door and a 5 door hatchback, and similar outline they 
may be shown on the same RVD as the NSW Body Shape would be ‘SED’. 

• Where a Utility is available as a Single Cab, Extra Cab, etc the Body Style will be 
‘Utility’. The type of Cab should be included in the Variant Identification. 

• If a 3 Door and 5 Door Sedan or Single Cab and Dual Cab are included on one RVD 
then Images supplied may show Front view of 3 Door, and Rear view of 5 Door etc.  

• Embargo Date:  If the RVD has and embargo date, the RVD will not be released to the 
website or State and Territory Registering Authorities until that date has passed.  When 
setting an embargo date manufacturers should allow at least 2 weeks after that date for the 
RVD to be received at all Registering Authorities. 

 

Make/Model 
Make/Model must be the same as shown on the CA form. 

 

Marketing Designation 
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Marketing designation may be the same as the Model name. Where the Model name is a code 
(eg. B1) and the vehicle is to be marketed by the name ‘Yahoo’, then the Marketing Designation 
should show ‘Yahoo’. 

 

Proposed SUTI Date 
The RVD has prevision for a proposed SUTI date, which should be completed when the RVD is 
first submitted.  VSS will endeavour to schedule the SUTI as close to that date as possible.  If a 
proposed SUTI date is not provided the manufacturer should provide at least 4 weeks notice of 
proposed inspection date. 

 

Body Style/NSW Body Shape 
Body Style may be Sedan, Liftback, Hatchback, Coupe, Station Wagon, Wagon, Utility etc.  

For motorcycles ( LA, LC ) Body Style should be ‘Solo’. 

 

NSW Body Shape 

• Coupe (Cou) is a vehicle that has 2 doors and 2 seating positions only.  

• Sedan (Sed) is to be used for vehicles having 2/3/4/5 doors and 4 or more seating positions. 

• Van (Van) is for vehicles, which have a separate Van body, built on a Cab/chassis. 

• (PVN), (PVS), and (PVW) is for vehicles which have a walk through body. 

• (PVF) is to be used for MC category vehicles, and for MC category vehicle which are also 
certified as NA category, and have a body style of wagon.  

• Utility (Ute) is to be used for utilities, which may have a Regular cab, Super Cab, Extra cab 
etc. 

• For MA and MB category vehicles which have a body style of Wagon and seat up to 8 
occupants will have a NSW body shape of (Wag) provided they meet the NSW station 
wagon requirements as shown in section 5 of the SUTI manual (Circular 0-14-4). 

 

Variant Identification 
Each variant must be identified on the RVD form by name (eg. Executive, GLS etc) or by the 
manufacturers variant code (eg. 123-ABC, etc), where such codes are used to identify vehicles 
for marketing purposes. Examples of this would be different variant codes for body style 
identifiers, engine options or distinct trim levels, which set the variant apart from other variants 
of the same model. It is expected that the variant name or manufacturer’s code would appear on 
the vehicle. 

For MD and ME category vehicles built on a separate chassis/s, and the chassis/s have a Sub-
Assembly Registration Number (SARN) then the SARN/s should be included under the Variant 
name. If there is not enough space in the Variant name then this information should be included 
in the remarks section.  

 

Tare Mass 
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Tare Mass shall be indicated to the nearest 5kg for vehicles and the nearest kg for motorcycles. 
Tare Mass for a particular variant should be the mass of that variant, with all standard 
equipment, but without any options fitted.  

 

Gross Vehicle Mass (GVM) 
The GVM need not be shown for LEP, LEG, MA, MB, and MC vehicles. 

 

 
 
Towing Mass (Braked/Non-Braked Trailer) 
This is the Manufacturer’s recommended Towing Mass. If the manufacturer does not 
recommend towing then ‘0’ should be inserted.  ADR 38/-- requires that all trailers over 750 kg 
must have brakes, therefore Maximum Towing Mass ( Non-braked trailer ) must not be more 
than 750kg. 

 

Engine Capacity 
The Engine capacity shall be indicated to the nearest millilitre.  For rotary engines;   

Engine Capacity = Single Chamber Displacement of One Rotor x 2 x Number of Rotors. 

 

Net Engine Power 

Net Engine Power may be rounded down to the nearest kW(ECE). 

 

Typical Engine Number 
The engine number is expected to uniquely identify an engine from others of the same engine 
manufacturer. Where there is cast characters or additional characters which identify the engine 
type these should be recorded in the remarks section. 

 

Ground Clearance 
Ground Clearance as defined in ADR 43/04 Clause 6.4.1. 

 

Standard Equipment or Options Affecting ADR Compliance 

Apart from items shown under this heading the following items should be included; 

 Front Bench Seats 

 Sun Roof ( Power/Manual/Glass ) 

 Alloy Wheels 

 Rear Spoiler ( with CHMSL )    
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 Side Air Bags. 

 Tow Bar. 

Items such as Audio systems, Floor mats, Leather trim need not be listed.  Options apart from 
Engines and Transmissions need only be shown as ‘S’ ‘O’ or ‘NA’. 

 

Tyre and Rim Information 

The information corresponding to all tyre and rim combinations displayed on the tyre placard on 
the vehicle is required to be provided on the RVD form. Temporary Use Spare Tyre (TUST) 
and rim information should not be shown in this section but listed in the Remarks section.  

 

Superseding and Correcting RVD’s 
Supersede/Correct can only be used to supersede or correct an already ‘Approved’ (Passed) 
RVD in RVCS. 

 

Supersede 

Supersede is only used for adding a new variant/s, additional engine, additional Tyre/Rim 
combinations etc, and should only add additional information. Original information must not be 
changed. 

 

Correct 
Correct is only used to correct information previously submitted that was wrong eg. GVM was 
incorrectly stated. 

 

 If a RVD has to be resubmitted as a result of a Discussion List item or incorrect 
information has been provided, and the previously submitted RVD has not been ‘Approved’ 
(Passed), then a Post-It note should be attached to the top of the RVD requesting the 
previous RVD be withdrawn.  

 If an RVD has been ‘Approved’ (Passed) it cannot be withdrawn, it must be 
Superseded or Corrected. 

 

Notes ( Post-It notes) 
Post-it notes should not be used to show information, which may be applicable to Registering 
Authorities, eg variable wheelbase for NC vehicles. This information should be shown in the 
remark's section.  
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RVD Images 
RVD Images may be submitted electronically or on paper. 

 

Electronic Images 
Electronic images are to be attached to a single file, front ¾ and rear ¾ views, of opposite sides 
of the vehicle, side by side (ie, merge the two images into a single file), maximum size each 
view 85x50 mm (total 170x50), and the file attached to a RVD image form. Image file should 
be in JPEG or JIF format (not BMP), 8 bit (ie, 256 colour), 80 dpi. An RVD image may be 
associated to one or more RVD’s, but only one image file must be attached to an RVD Image 
Form. 

 

Paper Images 
Attach front ¾ and rear ¾ view, of opposite sides of the vehicle, within the spaces provided to 
an RVD Image Form. Photo’s may be colour or black and white, each a maximum of 85 x 
50mm. An RVD image form is to be provided for each RVD unless the image is associated with 
more than one RVD. 

If an RVD is covering a 3 door and 5 door sedan etc, then Image file should show front ¾ view 
of 3 door and rear ¾ view of 5 door, of opposite sides of the vehicle. 

  

Grid Locations 
Grid location charts for Typical VIN, Typical Engine Number and Compliance Plate location 
are contained in Section 3 of the SUTI manual. 

Reference to location should be given as; Chart number, Alpha-Numeric location on the grid.  

eg. 5-E-17 or 3-O-5. 

 

Remarks Section 
If the vehicle is subject to Second Stage manufacture, there should be a brief description of the 
modifications in the remarks section, particularly where the RVD of the original vehicle has 
been affected. Information should include original base vehicle CPA number, RVD reference 
and variants on that RVD to which second stage manufacturer is applicable. 
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Working with Informed Filler 
RVCS enables vehicle manufacturers to submit vehicle certification applications on electronic 
forms with the use of Informed Filler software.   

Informed Filler has comprehensive on-line help to assist you in using Informed Filler to work 
with electronic forms.  You can access Help by choosing Contents from the Help menu. 

This section provides additional information to assist in you completing and submitting RVCS 
forms using Informed Filler. 

Moving through a Form 
An electronic form contains fields or ‘cells’ in which you enter data.  When filling out a form, 
you need to enter data in each cell in sequential order, starting from the top and working down 
the page, left to right.  Working in this order allows validation rules incorporated into a form to 
work correctly. 

You can use the mouse to select the next cell to complete, however the validation rules may not 
behave correctly.  Data is only validated when the cell is exited (ie. when the cursor is tabbed to 
the next cell or moved, using the mouse, to another cell). 

Moving through Cells and Tables (Windows) 

Press Action 

Tab Moves forward to the next cell. 

Shift+Tab Moves backwards to the previous cell. 

Enter Acts the same way as Tab for cells that can not have more than one line. 

 

Entering Data 
To fill out a form you enter information into each cell on the form.  The cell which is currently 
selected is called the ‘current cell’.  Form cells are formatted according to the type of data they 
can hold: 

Text Alphanumeric (A-Z, 0-9) 
Left Aligned 

Numeric Numeric (0-9) 
Right Aligned 

Date Automatically formatted as DD\MM\YYYY. 
If you enter 27 Jan 97 into a formatted date cell, the date is 
automatically converted to the correct format, 27\01\1997. 
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Validating Data 
Forms in RVCS contain data validation symbols which assist you in entering data required for 
the form.  Use the following symbols as a guide when entering data: 

 The data entered does not correctly match the validation 
conditions for this cell. 

 The data entered may be incorrect or you have not yet entered data 
into this cell. 

Red border A red border around a cell indicates a display only cell.  You can 
not access, nor enter data, into a display only cell. 

Note: If you need to clarify or explain data entered in a cell, place a note on the 
form adjacent to a cell.  See Entering Notes or Comments on Forms on 
page 25. 

Selecting from a Drop-down List 
A cell can contain a drop-down list from which you can select a value specific to that cell.   For 
example, a cell specifying a type of reflector could list rear reflector, side reflector or front 
reflector as possible values. 

In RVCS, an arrow (τ) on the right side of a cell indicates the cell contains a drop-down list.  
The selected value of a drop-down list is ticked. 

 
You can select a value from a drop-down list using the mouse or by entering the first few 
characters of the value.  For example, if you enter S in the above example, Side Reflector will 
be selected.  When you have selected the correct value, press Tab to accept the selected value 
and move to the next cell.  If you press Tab without selecting a value, Informed Filler leaves the 
cell blank. 

The values in a drop-down list may contain descriptive text, which is not shown in the cell, 
when a value is selected.  In the following example, if you select Dynamic (D), only the text in 
parenthesis, in this example D, is shown in the cell. 

 

Values for reflectors on 
a vehicle. 

Choose Dynamic (D) 
from the list and only 
the D is shown. 

Drop-down list indicator.   
To display the drop-down list, 
click on the arrow. 
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Selecting from Pop-up List 
A cell can contain a pop up list, from which you can select a value specific to that cell.  For 
example, when you Tab into the ADR cell on the RVCS Blank Sheet form a list of available 
values pops up. 

You can select a value from a pop-up list using the mouse or by entering the first few characters 
of the value. For example, if you enter 57 you would be able to select 57/00 from the ADR pop-
up list.  When you have selected the correct value, press Tab to accept the selected value and 
move to the next cell.  If you press Tab without selecting a value, Informed Filler leaves the cell 
blank. 

 

Attaching Files 
Informed Filler allows you to attach electronic files to forms.  Any file, regardless of its size or 
content, can be attached to a form.  Although not visible on the form itself, an attached file 
becomes part of the form and is stored with the form. You cannot amend an attached form. You 
must remove the attachment (see page 24), make changes to original file and then attach the file 
again. 

Using RVCS, you can attach forms to a Routing Slip before submitting applications 
electronically to VSS. 

 

Note: You can attach electronic files to Summary of Evidence forms if required, 
but only in exceptional cases.  Before attaching other electronic files to the 
form, ensure VSS can read them.  (VSS supports common file formats, 
such as Word, Excel and Access.) 

Listing Attached Files 

 

 

Above the right scroll bar is a paper clip symbol above a number.  
The number indicates the number of files attached to the current 
form. 

Files attached to a form are not visible on the form itself.  Attached application forms are listed 
in the Attachments window.   For example: 
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To show the Attachments window, click on the paper clip symbol. 

Attaching Files to Forms 
You can attach files to a form by dragging the files onto the paper clip symbol or onto an open 
Attachments window or by using the Attach command. 

Note: Windows 3.x does not have a dragging capability. 

To attach files by dragging 

1. Ensure both Informed Filler and File Manager, or Windows Explorer, are open 
and visible, and that the form you wish to attach files to is open in Informed 
Filler. 

2. Using File Manager, or Windows Explorer, select the files you wish to attach. 

3. Use the mouse to drag the files onto the paper clip symbol in Informed Filler 
or into the Attachments window, if open. 

To attach files using the Attach Command 

1. Ensure the form you wish to attach files to is open in Informed Filler. 

2. Choose Attach… from the File menu or click the paper clip symbol to open 
the Attachments window and click Add.   

The system shows the Attach dialogue from which you can select a file to 
attach: 

 
Note: You can only attach one file at a time using the Attach dialogue. 

3. Select the file you want to attach, then click OK.   

4. To attach another file, repeat steps 2 and 3. 
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Deleting Attachments from Forms 
Deleting an attachment to a file only deletes the attachment to the file; it does not delete the 
original file. 

To delete an attached file from a form 

1. In Informed Filler, click the paper clip symbol to open the Attachments 
window. 

2. Select the file attachment you want to delete from the form. 

3. Press Backspace or Delete to delete the attachment. 

When prompted to confirm the deletion, click OK. 

To delete all attached files go to Edit, Select All and then select delete 

Entering Notes or Comments on Forms 
In addition to the information that you enter in each cell on a form, you can also enter annotated 
notes or comments using Informed Filler’s annotation facility.  An annotated note is usually a 
comment to bring something important to the reader’s attention.  For example, a note attached 
to an application explaining why the data in the cell does not match validation requirements. 

Informed Filler uses the yellow ‘Post-It note’ method to show annotated notes.  You can place 
and position notes on any form.   For example: 

 

Placing, Moving and Removing Notes 
Informed Filler allows you to place and position  notes where required. 

To work with notes 

1. Place a new note by choosing Place Note from the Edit menu.  A blank note 
is shown centred in the form window. 

A note is shown on your 
screen much like a piece of 
yellow paper is attached to a 
paper form. 
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2. Enter, view, or change the text of a note by clicking the note’s Text 
Control icon: 

 
The system displays the Note dialogue which you can use to enter, view or 
change the text as required.  Click OK to save the note. 

Informed Filler only displays the first few words of a textual note on the note 
itself.  If the entire note doesn’t fit in the space provided, you will see only the 
first few words followed by an ellipsis (‘...’).   

3. Move a note by clicking on the note and dragging it to the required position. 

4. Remove an existing note by clicking on the note then choosing Clear from 
the Edit menu, or by pressing Delete.  

Sharing RVCS Files on a Network 
If you are running Informed Filler on a network, the RVCS files (templates and test facility auto 
entry file) can be located in a shared directory on a network drive to simplify maintenance in a 
multi-user environment.  As this directory will not be the default directory you will need to 
specify the location of these files in Informed Filler. 

The drop down list data file chlist.txt can not be shared.  Whilst it can be located in a shared 
directory Filler will not function correctly if another user is accessing the file.  VSS 
recommends that the chlist.txt file is located on each user's local hard drive. 

VSS will provide you with updated templates, new templates and an updated drop-down list file 
chlists.txt (either directly or off the Internet); the test facility auto entry file, commtfi.ifm, will 
change as users on the network add or edit test facility details. 

Note: Changing folder location using Informed Filler’s Preferences dialogue does 
not automatically move the contents of the folder to the new location.  You 
must do this yourself. 

 When commtfi.ifm is moved each template which uses this file may need to 
be updated to look for the file in the correct location.  See Commtfi.ifm File 
Not Found on page 35. 

To specify the location of RVCS files in Informed Filler 

1. Choose Preferences from the Informed Filler Edit menu. 

2. Select the Folders icon to display the Folders Preferences dialogue. 

Text Control icon 
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Informed Filler looks for the Templates and Preferences folders inside the 
Informed folder unless another folder is specified as the alternate template or 
preferences folder location.   

3. For templates, enter the new location for the RVCS templates in the Alternate 
templates folder location box or click Browse… and click on the desired 
location (in this case, your shared directory). 

4. For supporting files, enter the new location for the supporting files in the 
Alternate preferences folder location box or click Browse… and click on the 
desired location (in this case, your shared directory). 

5. Click OK to save the preference settings. 

6. Move the contents of the folder(s) to the new location(s). 

Setting Startup Preferences 
When you start Informed Filler the system briefly displays the welcome screen, then displays 
the New Data Document dialogue from which you can select a template to create a new form.  
To open an existing form you must first cancel the New Data Document dialogue and then 
choose Open… from the File menu to display the Open dialogue. 

You specify whether your preference is to create a new form or open an existing form at startup 
using Informed Filler preferences. 

To modify startup preferences 

1. Choose Preferences... from the Edit menu.  The system displays the 
Preferences dialogue. 

2. Click the General icon.  The system displays the General Preferences settings: 
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3. Select one of the following startup options; 

• Create new data document (default) 

• Open existing data document 

4. Click OK.  If you change the preference, the new setting will take effect the 
next time you start Informed Filler. 
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Using RVCS Features 
RVCS contains several facilities designed to assist vehicle manufacturers in completing and 
submitting forms. 

While using Informed Filler, you can automatically enter test facility information on forms.  
While using the RVCS web site, you can check the status of your applications, view discussion 
lists associated with your applications, upgrade the software required for RVCS (Informed 
Filler, templates and supporting files) and change your RVCS password. 

Entering Test Facility Data Automatically 
RVCS contains a Test Facility Auto Entry form which you can use to store details of frequently 
used test facilities for RVCS forms.  The utility enables you to store test facility name and 
address details and retrieve them simply by entering the test facility’s identifying number on an 
application form. 

To use the Test Facility Auto Entry form, you must first create the form based on the Test 
Facility Auto Entry form template, tfinfo.itp. 

To create the Test Facility auto entry form 

1. If the New Data Document dialogue is not already shown, choose New 
Document...  from the File menu.   

2. Select the Common Test Facilities form template from the list. 

3. Click New.  The system displays the following dialogue: 

 

5. Choose Save As  from the File menu. 

6. Save the file as commtfi.ifm in the \Informed\Prefs directory or elsewhere if 
you have changed your preferences folder location. 
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Note: You can only create and maintain one test facility form.  Informed 
Filler only recognises the test facility form named commtfi.ifm. 

Unlike other RVCS electronic forms, the test facility form can contain 
multiple records.  Each record contains information on a different test facility. 

When records have been added, use the <<Prev and Next>> buttons to scroll 
through the records. 

To add a new test facility record 

1. If the fields contain data, click New. 

7. Enter the VSS-issued test facility number, and the name and the address of the 
corresponding test facility. 

8. To enter another record, click New. 

9. When you have entered all required records, choose Close from the File menu 
ensuring you save the changes. 

To update test facility records 

1. Use <<Prev, Next>> or List (see To list existing test facility records below) 
to display the test facility record you want to update. 

10. Modify the name and address details as required. 

11. When you have entered all required records, choose Close from the File menu 
ensuring you save the changes. 

To remove a test facility record 

1. Use <<Prev, Next>> or List (see To list existing test facility records below) 
to display the test facility record you want to remove. 

12. Click Remove. 

13. Click OK when prompted to confirm the deletion. 

14. When you have entered all required records, choose Close from the File menu 
ensuring you save the changes. 

To list existing test facility records 

1. Click List.  The system lists the existing test facility records. 

2. Open a test facility record from the list by double-clicking on the record.  
The system displays the record details. 

3. Print this list by choosing Print from the File menu. 



 
RVCS User Guide 

 

Page 31 

Checking Application Status & Discussion Items 
After you send your application to VSS, it may take one or more days for VSS to process the 
application to a point where an acknowledgment can be generated.  The receipt of your 
application will show about 4 hours after you send it.  As your application is processed, there 
may be items which VSS wants to discuss with you.  These are called discussion items. 

You can view the status and discussion lists for your applications on the RVCS web site.    You 
will be notified by email, fax or post (as appropriate) of the application number associated with 
each application, which you will require in order to check the status of the application.  The 
application status page includes a list of all forms received and their current status.  It also 
records the submission number and batch number in which the forms were received.  

To check your application status and discussion list 

1. Go to the RVCS home page at:  http://www.dotrs.gov.au/rvcs 

2. Logon to RVCS.  See Logging on to RVCS on page 3. 

3. On the Registered User page, click either List Applications for a list of all 
applications you are authorised to view or Application Search to check a 
single application. 

4. If you selected Application search, enter the number of the application you 
want to check on the Application Search page.  Select either Application 
Status to view the application status or Discussion List to view the discussion 
items. 

5. If you selected List Applications click on the number for the application 
status or the number of discussion items for a list of discussion items 

6. Check the application status by selecting Application Status.   

The system displays the Application Status page showing the current status of 
the specified application, including date information and number of discussion 
items.  Click on the underlined phrase Application Status to view the 
application status. 

7. View the discussion list by selecting Discussion List.   

The system displays the details of any discussion items related to the specified 
application.  Click on the underlined phrase Discussion List to view the 
discussion items. 

 

Upgrading Required Software 
VSS will notify you of any mandatory upgrades or new releases of the RVCS software 
(Informed Filler, RVCS templates and supporting files).  The What's New page on the RVCS 
Web site contains information on updates etc.  

Upgrading Informed Filler 
You can download new releases of Informed Filler from the RVCS web site.  Instructions on 
how to install the upgrade will be available from the web. 
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Note: VSS may not automatically apply all upgrades to the Informed Filler 
system.  If you download an upgrade directly from Shana (company 
responsible for Informed Filler), the RVCS forms may behave differently. 

Latest Version of RVCS Form Templates 
For small upgrades, you will need to download form templates from the Internet as per 
instructions at the RVCS web site.  See Downloading Form Templates off the Internet on page 
6. 

For major upgrades, a cut-off date will indicate the last day on which VSS will accept electronic 
forms based on the old version of a template.  After the cut-off date, VSS will not accept 
application forms on the old template.  You will be notified in advance of any cut-off dates. 

Note: The last date VSS will accept submissions on 'old' (pre-RVCS) forms is 31 December 
1999. 

The last date VSS will accept submissions in a paper format will be 31 December 2000.  All 
submissions after this date must be made electronically. 

RVCS Form Identifiers 
ADR Related Forms 

The ADR number indicates the ADR rules which the form template adheres to, with a prefix 
indicating the type of form.  SE for Summary of Evidence, SF for Selection of Fleet. 

For example, the form template SE 24\02 identifies an SE form templates which relates to the 
ADR rule 24\02. 

ADR Issue Number

Form Template
Issue Number

 

 

Non ADR Related Form 
These forms have an abbreviation related to their functions, eg CA (Motor Vehicle) for 
Compliance Application, Motor Vehicle 

 

Form Template Issue Numbers 
Issue numbers are shown on the top right corner of a form and refer to the current release of the 
form.  Many of the forms have previously been released as paper forms, so the first electronic 
form carries issue 2 or later.  The issue number initially related to the paper format only, but 
starting November 1999 reflects changes to both paper and electronic content thus becoming the 
same as the form's revision number. 
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Revision Numbers 
Revision numbers reflect changes to form templates.  The first digit reflects the major change 
sequence, the second digit reflects the minor change sequence.  For example, if a form template 
with the revision number 2.5 has a spelling error, a corrected version would be re-issued with 
the revision number 2.6.  Version 1.x refers to the development versions. 

Revision numbers for new issues start at ‘2.0’.  (For a major upgrade, the revision number 
changes from 2.6 to 3.0. 

Revision numbers are shown in the Template Information dialogue, or in the New Form 
dialogue when you create or open a form. 

CD-ROM Release Number 
The CD-ROM release number uses the same numbering technique as the form revision number.  
The first digit is increased when a significant number of forms change, the second digit changes 
when a lesser number of forms change.   

The first production release of electronic forms (release 1.0 February 1998) contains forms at 
revision 2.0 status. 

The second release, which added motor vehicle forms, was labelled release 2.0.  It contained 
forms with various revision numbers. 

Changing Your Password 
When you receive your web user name and password from VSS, you can logon to the VSS 
RVCS web site and change your password. 

Notes: 1. If you can not remember your password, contact the RVCS Help Desk 
on (02) 6274 7766 or via e-mail at rvcs@dotars.gov.au. 

 2. Agents will not be issued with a web user name and password until they 
are nominated as a signatory by a registered Licensee. 

To change your password 

1. Go to the RVCS home page at:  http://www.dotars.gov.au/rvcs 

15. Logon to RVCS using your existing password.  See Logging on to RVCS on 
page 3. 

16. At the RVCS page, click Change Password. 

Enter your current password and your new password.  Re-enter your new 
password to verify it.  A password must contain at least six characters with a 
at least two alphabetic characters and one non-alphabetic character. 

17. Click Submit Password. 
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Troubleshooting 
The following information describes solutions to possible problems you may encounter using 
RVCS electronic forms to complete and submit applications. 

If a problem or an error occurs that is not described in this section, please contact the RVCS 
Help Desk: 

Phone:  (02) 6274 7766 
Fax:  (02) 6274 6525 
E-mail:  rvcs@dotars.gov.au 

Printing Problems 
Form printout is black, without text  

1. Change some or all of the following  printer settings. 

Tab Cell Value 

Details Spool Settings Print directly to the printer 
(Windows 95 only) 

Graphics Dithering Coarse 

 Intensity 100 

 Graphics Mode Use Raster Graphics 

Fonts TrueType Fonts Print TrueType as graphics 

Device Options Print quality RET – Printer Default 

 

18. If your form printout is still black and without text, using a text editor, such as 
NotePad, open the following file: 
informed.ini 

(The informed.ini file is usually saved in the C:\Win95 directory or C:\Windows 
directory depending on your operating system.) 

19. Insert the following line (below other lines starting with PREF): 
PREF_PrintNoClips=TRUE 

Drop-down List Error 
Informed Filler can not find the drop-down list data 

If no list displays when you click on the drop-down arrow (τ) you should check to ensure that 
the Chlists.txt file is in the folder specified for Alternate Preferences (see page 26). 
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Lost Folders 
Informed Filler can not find any of the Informed Filler templates or preferences folders 

When you start Informed Filler or select to create a new form, Informed Filler must be able to 
locate the folder containing the templates and preference settings (usually 
C:\Informed\Templates and C:\Informed\Prefs). 

Informed Filler will display a dialogue prompting you to locate or create the missing folder or 
cancel the operation. 

• Click Locate to look for the folder and select its new location 

• Click Create to create the Prefs or Template folder in the Informed folder 

Notes: 1. Clicking Cancel  may cause a program error (general protection fault) 
and Informed Filler will shutdown. 

 2. If the folders Preferences have been changed, for example in the case of 
Sharing RVCS Files on a Network on page 26, you must also move the 
files within a folder to the new location. 

Commtfi.ifm File Not Found 
Informed Filler can not find the commtfi.ifm file 

When entering a test facility number in the Test Facility cell on a form, Informed Filler must be 
able to locate the commtfi.ifm file.  See Entering Test Facility Data Automatically on page 29 
and Sharing RVCS Files on a Network on page 26. 

Informed Filler will display a dialogue prompting you to look for the missing file, or to skip or 
disable the operation. 

• Click Look to locate the file and select its new location 

• Click Skip to ignore the lookup this time only (the Look dialogue will occur if 
you change the test facility number again, before closing the form or template) 

• Click Disable to ignore the lookup until the form, or template, is closed and 
later opened again 

New Document Does Not Open a Form 
You choose New Document… from the File menu, select a template name, click on New, and 
the form does not open. 

This can occur if the support file chlists.txt can not be found in the folder nominated for your 
preferences or the chlist.txt file is in use by someone else on your network.  See Sharing RVCS 
Files on a Network, on page 26, for how to check or change your preferences folder.  If the 
setting looks correct, use File Manager or Windows Explorer to check that the chlists.txt file is 
in the selected folder. 

Display Only Cells 
When you click on a text cell the “Display only cell” error message  

When you click in a cell the following error message displays: 
This is a display only cell.  You cannot change its value 
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You have clicked on the space where a bell or cross symbol resides.  To continue working: 

2. Click OK to close the error message. 

3. Click in the cell at the opposite end to the bell or cross symbol. 

 

You have clicked in to a read only cell (red border) 

1. Click OK to close the error message. 

2. Click in a different cell which does not have a red border. 

 

Blank Patches 
The screen may not at all times produce a complete image on the screen (blank patches).  

This can be corrected by using the minimise and maximise functions of your window (top right 
hand corner). 

 

File Submit problems 
 

Problem 
The File Submit function in the RVCS Routing Slip gives a “Waiting for Network .. “ message 
followed by “This form has a submit configured … “ error message. 
Solution 1. 

Ensure an open Internet connection is in place before using File Submit. 

Solution 2. 

Check the proxy settings being used. 

Many Internet Service Providers (ISP) now use a proxy server between the user (you) and the 
Internet or World Wide Web, WWW).  In these cases, when you dial up to make an Internet 
connection you actually connect to a proxy server.  The proxy server is connected to the Internet 
and hence you have an Internet connection.  Proxy servers do not respond in the same way as a 
direct Internet connection.  Informed Filler becomes confused when communicating with a 
proxy server.   

 

Configuring for Use with a Proxy Server 
1. Start Informed Filler 

2. Choose Edit/Preferences menu item 

3. Select the icon labelled ‘Internet’ 
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4. Select the ‘Set Preferences’ button 

 
5. Check (Turn on) the ‘Use HTTP proxy at:’ check box 

6. In the text box provided, enter the IP address or name of your proxy server, 
including a port number if necessary. The format for a valid proxy entry is address:port or 
name:port, where the ‘:’ character acts as a separator between the address/name and port 
number. Examples of valid proxy settings are: 

Address/Name Port Informed Filler Proxy Setting 
proxy.interact.net.au� 8080� proxy.interact.net.au:8080� 
203.17.154.19� 1234� 203.17.154.19:1234� 
yellow.bhp.com.au� � yellow.bhp.com.au� 

Do not guess at the correct value for this field! Contact your Internet Service Provider or 
computer support staff if in doubt. Alternatively, you may be able to obtain the correct proxy 
settings from your web browser. Refer to ‘Obtaining Proxy Settings from Your Web Browser’ 
at the end of this document. 
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7. Ensure that the ‘Use SOCKS proxy at:’ and the 'FTP proxy' check box is clear and that the 
corresponding text box is empty. 

8. Clear the ‘Don’t use proxies when connecting to these servers:’ text box 

9. Choose the ‘OK’ button 

10. Shut down Informed Filler 

11. Relaunch Informed Filler 

Obtaining Proxy Settings from Your Web Browser 
Choose the section below corresponding to your web browser and follow the instructions 

carefully. 
Microsoft Internet Explorer 5.0x 

1. Select the Tools/Internet Options menu item 

2. Select the 'Connections' tab 

3. In the LAN settings frame choose the 'LAN Settings' button 
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4. In the Proxy server frame choose the 'Advanced button' 

5. In the 'Servers' frame note the 'Proxy address to use' and 'Port' values corresponding to 
HTTP.  These two values make up your proxy settings.  The value to be entered into 
Informed Filler is created by joining the 'proxy address to use' with the 'Port' number with a 
colon (:) separating the two. 
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Microsoft Internet Explorer 3.0x 

1. Select the View/Options menu item 
2. Select the ‘Connection’ tab 

 
3. In the Proxy Server frame, choose the ‘Settings’ button 
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4. In the ‘Servers’ frame, note the ‘Address of proxy to use’ and ‘Port’ values corresponding 
to HTTP. Collectively, these values comprise your proxy settings. The value to be entered 
into Informed Filler is generated by joining the ‘Address of Proxy to use’ to ‘Port’ with a 
single ‘:’ separating the two values. See Configuring for Use with a Proxy Server for 
examples of valid proxy settings. Note that if no value is provided for ‘Address of Proxy to 
use’ and your web browser is operating correctly, you do not need to add support to 
Informed Filler for proxy servers. 

 



 
Using Electronic Forms for Vehicle Certification 

 

Page 42 

Netscape Navigator 3.x 

1. Select the Options/Network Preferences menu item 
2. Select the ‘Proxies’ tab 

 
 

 

3. If the ‘Manual Proxy Configuration’ radio button is selected, choose the ‘View’ button. If 
‘No Proxies’ is selected and your web browser is operating correctly, you do not need to 
add support to Informed Filler for proxy servers. If the ‘Automatic Proxy Configuration’ 
radio button is selected, you will not be able to obtain the proxy settings from the browser. 
Contact you network support staff instead.  
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 Note the values corresponding to ‘HTTP Proxy’, including the value for ‘Port’ 
if provided. Collectively, these values comprise your proxy settings. The value to be entered 
into Informed Filler is generated by joining the ‘HTTP Proxy’ to ‘Port’ with a single ‘:’ 
separating the two values. See 

Configuring for Use with a Proxy Server for examples of valid proxy settings. 
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Registering with VSS 
Access to the RVCS electronic forms and the RVCS web site is only available to licensees or 
agents of licensees registered with VSS. 

To register with VSS, you need to complete a registration (paper) form.  Registration forms are 
available from: 

VSS 

the RVCS Internet web site 

the ADR Subscription CD-ROM 

the RVCS Electronic Forms CD-ROM 

Complete the form and return it to VSS for processing. 

Once VSS has processed your application, you will receive a web user name (via e-mail) and 
corresponding password (via post). 

Note: Agents will not be issued with a web user name and password until they are 
nominated as a signatory by a registered Licensee. 

Obtaining Registration Forms 
Registration forms may be obtained in the following ways. 

To request a registration form via phone, fax or e-mail 

Contact VSS and provide your name and address details: 

 Vehicle Safety Standards 
Department of Transport and Regional Services 
GPO Box 594 
Canberra   ACT   2601 

 Phone:  (02) 6274 7766 
Fax:  (02) 6274 6525 
E-mail:  rvcs@dotars.gov.au 

To obtain a registration form from the Internet web site 

1. Go to the RVCS home page at:  http://www.dotars.gov.au/rvcs 

2. At the home page, select Registration. 

You can download a copy of the registration forms in Adobe Acrobat format 
from the Registration page, or request VSS send you paper copies of the 
registration forms (See To request a registration form via the Internet below). 

To request a registration form via the Internet 

1. Go to the RVCS home page at:  http://www.dotars.gov.au/rvcs 

2. At the home page, select Registration. 
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3. Enter the following details: 
Name Enter your name or your company name. 

 Tick the appropriate check box to indicate whether 
you are a licensee, agent, production facility, design 
facility, test facility or conformance body.  (You can 
select more than one.) 

Postal Address Enter your postal address, including state and 
postcode. 

Email Address Enter you e-mail address.  

 

4. Click Send Me a Form. 

To obtain a registration form from the ADR Subscription CD-ROM 

Use the Adobe Acrobat format files provided on the CD-ROM.  The files are located in the 
\eforms directory of the CD_ROM.  If you do not have Adobe Acrobat reader you can install it 
from the ADR Subscriptions CD-ROM. 

To obtain a registration form from the RVCS Electronic Forms CD-ROM 

Once you have installed Informed Filler as described in this User Guide you can open the 
document templates for the registration forms and print them as blank forms. 
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Getting Help 
If you need any information or assistance with electronic submission of application forms 
contact VSS: 

 Phone:  (02) 6274 7766 
Fax:  (02) 6274 6525 
E-mail:  rvcs@dotars.gov.au 

 Vehicle Safety Standards 
Department of Transport and Regional Services 
GPO Box 594 
Canberra   ACT   2601 

 

If the problem is found to be related to Informed Filler, the RVCS Help Desk will direct you to 
support provided by Shana (the producer of Informed Filler).  When contacting Shana you will 
need to quote the support contract number provided by the Help Desk. 
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Glossary 
A 

ADR Australian Design Rules for vehicle safety and 
emissions.  Currently there are 70 ADRs which have 
been determined as National Standards under the 
Motor Vehicle Standards Act. 

Agent A person or an organisation registered with VSS, 
who can be authorised to act on behalf of a licensee 
as a signatory. 

Annotation A note that you can attach to an item on a form 
template. 

Application Application for certification of a specific vehicle 
type, sub-assembly or component submitted to VSS 
for consideration. 

Application Number Application reference number assigned to an 
application by VSS. 

Attachments Electronic files attached to Routing Slips (usually 
electronic forms). 

C 
CA Compliance Application. 

Cell Text boxes on a form in which application details are 
entered. 

Compliance Plate Plate affixed to each vehicle for which Compliance 
Plate Approval (CPA) has been granted.  (Referred to 
as an Identification Plate in the Motor Vehicle 
Standards Act.) 

Component A constituent part of a vehicle subject to ADR 
compliance, which is common to several 
makes\models. 

CRN Component Registration Number.  Applies to 
compliant components. 

D 
Delegate A Delegate is a person authorised by a licensee to 

ensure adherence to the terms and conditions of the 
Compliance Plate Approval. 
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Document Register Lists documents included in the application 
submitted to VSS.  It also includes the Australian 
Design Rules the documents refer to, as well as any 
comments you have about the documents. 

Drop-down list Drop-down list from which you can select a value. 

E 
Evidence Data supplied by licensees when submitting 

applications.  Data is based on results of testing to 
demonstrate compliance with identified ADRs. 

Extension Sheet Required when you have more than one test facility 
for a Summary of Evidence form.  Complete and 
attach it to the corresponding Routing Slip.  One 
Extension Sheet can be used for more than one 
Summary of Evidence form. 

F 
Folder A directory on your computer or network. 

L 
Licensee A person or an organisation registered with VSS for 

the purpose of submitting applications for 
certification of vehicles, sub-assemblies and 
components, and who is issued with authority to fit a 
compliance or certification plate to an approved 
vehicle, or is given certification approval for a sub-
assembly. 

A licensee is the legal entity ultimately responsible 
for ensuring that only compliance plates are fixed and 
are only fixed to vehicles meeting the requirements 
of the Motor Vehicle Standards Act, or specified in 
the Compliance Plate Approval. 

Licensees must complete the registration process 
before an application for certification, submitted by 
them or on their behalf, can be approved by VSS. 

R 
Routing Slip A form used to submit application forms to VSS. 

RVCS Road Vehicle Certification System. 

RVD Road Vehicle Descriptor 
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S 
SARN Sub-Assembly Registration Number.  Applies to a 

compliant sub assembly 

SE Summary of Evidence form 

SF Selection of Fleet form 

Signatory A Signatory is a person or Agent authorised by the 
delegate to act on behalf of the licensee for the 
purpose of obtaining a Compliance Plate Approval. 

Sub-assembly Collection of components for which ADR 
certification is sought, for example, diesel engine, 
bus chassis. 

V 
Vehicle A road vehicle subject to ADR compliance.  There 

are several defined classes of motor vehicles and 
trailers. 

VSS Vehicle Safety Standards 
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additional information 
blank sheet form, 11 
notes, 25 

ADR number, 32 
amending an application, 9 
annotation. See notes 
application 

low volume motor vehicles, 11 
overview, 9 
status and discussions lists, 31 
tracking, 10 

assistance. See help 
attachments 

overview, 23 
supported file formats, 23 
window, 23 

bell symbol, 22 
blank sheet form, 11 
CD-ROM, installing 

Informed Filler from, 5 
cells 

drop-down lists, 22 
entering data, 21 
moving through, 21 
pop up lists, 23 
symbols, 22 

changing passwords, 33 
chlists.txt 

not found, 35 
commtfi.ifm, 26 

common test facilities, 29 
not found, 35 

completing forms, 11 
create. See new 
crossed-box symbol, 22 
data 

correct, 22 
entering, 21 
validation, 22 

data document. See form or 
template 

date 
cut off for upgrade, 32 
form template release date, 33 
format, 21 

delete 
attachment, 25 
note, 26 
test facility from auto entry, 30 

directory. See folder 
disable lookup, 35 
discussion lists, 31 
document register, 10 
drop-down list, 22 

not displayed, 34 
enter data in form, 21 
error. See help 

existing form, 13 
extension sheets, 10 
extention sheet, 48 
field. See cell 
file 

commtfi.ifm, 29 
commtfi.ifm not found, 35 
location, 27 
network sharing, 26 

file formats supported, 23 
folder 

for commtfi.ifm, 35 
location, 27 
not found, 35 
preferences, 26 

form 
commtfi.ifm, 29 
cut off date for old version, 32 
entering data, 21 
new, 12 
open existing, 13 
print, 15 
RVCS Registration, 44 
test facility auto entry, 29 

forms 
completing, 11 
submitting, 9, 14 
tracing submitted, 13 
working with, 21 

hardware, 2 
help, 21 

drop-down list not displayed, 34 
folder not found, 35 
Informed Filler general 

protection fault, 35 
password, 33 
printout black, no text, 34 
Shana, 46 

Informed Filler 
downloading off the internet, 4 
installing, 5 
registration number, 8 
starting, 8, 12 

Internet. See also web site 
downloading Informed Filler, 4 

list 
attachments, 23 
drop-down, 22 
drop-down not displayed, 34 
pop up, 23 

locate 
commtfi.ifm, 35 
folder, 35 

logon, 3 
Macintosh 

system requirements, 2 
network, sharing files, 26 
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new 
application, 9 
Common Test Facility form, 29 
folder location, 27 
form, 12 
note, 25 
test facility, 30 

new version. See version 
notes 

overview, 25 
placing, 25 
removing, 26 
text messages, 26 

password web site, 33 
pop up lists, 23 
preferences 

folder location, 26 
folder not found, 35 
startup, 27 

print 
form, 15 
troubleshooting, 34 

problems. See help 
red bordered cells, 22 
register Informed Filler, 8 
release. See version 
remove. See delete 
revision number, form 

template, 33 
routing slips, 9 

extension sheets, 10 
submit, 10 

RVCS 
downloading templates, 6 
how to register, 44 
overview, 1 
web site password, 33 

select 
attachments, 24 
from drop-down list, 22 
from pop up list, 23 
template, 12 

send application. See 
submitting 

Shana Informed Filler 
version, 32 

sharing files on network, 26 
software, 2 
specifications, 2 
submitting 

applications, 14 
discussion lists, 31 
forms, 14 

system requirements, 2 
template, 6 

cut off date for old version, 32 
test facility auto entry, 29 
text messages, 26 
tracing 

applications, 10 
submitted forms, 13 

troubleshooting. See help 
upgrade. See version 
using 

forms, 21 
notes, 25 
templates, 12 

validating data, 22 
version 

form release number, 33 
form template issue number, 32 
Informed Filler, 32 

view 
notes, 26 
status and discussions lists, 31 

web site 
discussion lists, 31 
logon, 3 
password, 33 
RVCS registration, 44 

Windows 
installing software on, 4 
system requirements, 2 

 


